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Chapter

1
 Copyright Notices

Copyright©2022 – Expert4x, all rights reserved. This eBook is intended for the purchaser’s personal
use only. No part of this eBook may be reproduced or transmitted in any form whatsoever, electronic,
or mechanical, including photocopying, recording, or by any informational storage or retrieval system
without expressed written permission from Expert4x.

Copyright©2022 EAfactory, all rights reserved. All title, including but not limited to copyrights, in
and to the TradeReceiver EA and any copies thereof are owned by EAfactory or its suppliers. All
title and intellectual property rights in and to the content which may be accessed through use of the
TradeReceiver EA is the property of the respective content owner and may be protected by applicable
copyright or other intellectual property laws and treaties. All rights not expressly granted are reserved
by EAfactory. For the full details please refer to the End-User License Agreement ("EULA").

https://doc.eafactory.com/Expert4x/TradeReceiver/MT4/latest/release/eula.txt


Chapter

2
 Getting Started with the TradeReceiver EA

Getting Started provides a guided exploration of the TradeReceiver EA. It is geared for an audience that
has little or no knowledge of installing an MT4 EA. It walks the novice user through downloading and
installing the TradeReceiver EA.

2.1 Installing the TradeReceiver EA
The TradeReceiver EA comes with a setup application to provide a wizard based installation process to
the selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT4 terminal version 4.00 build 1353 or later installed.

1. Exit the MT4 if it was running.
2. Visit the TradeReceiver EA Web Support Centre page.

3. Read the Web Support Centre Terms and Conditions and Privacy Policy then tick the checkbox to
accept them.

https://my.eafactory.com/expert4x/products/TradeReceiver/details/#download
https://my.eafactory.com/termsandconditions.jsp
https://my.eafactory.com/privacypolicy.jsp
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4. Click on the Download EA Setup button to download the EA setup for the MT4 terminal.

5. Run the downloaded setup application. Select the MT4 instance through the setup wizard pages
to where you want the EA to be installed.

6. When the setup completes start the MT4 up. The TradeReceiver EA entry should appear under
the Expert Advisors node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.
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The setup application lists the available MT4 instances. Select one of them for installation target and
click on the Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances. In this
case run the setup application as administrator and use the Add target directory... button to
navigate and pick up the desired folder.

The default MT4 installation location would follow this pattern:

C:\Program Files (x86)\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader terminal
installation. As a hint, the following shows you the default path to the main MT4 directory for
some brokers:

Broker Default Path

Blueberry Markets broker
C:\Program Files (x86)\Blueberry Markets MetaTrader
4 Terminal

Dukascopy broker C:\Program Files (x86)\Dukascopy MetaTrader 4

IG broker C:\Program Files (x86)\IG MetaTrader 4 Terminal
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Broker Default Path

OANDA broker C:\Program Files (x86)\OANDA - MetaTrader

Pepperstone broker C:\Program Files (x86)\Pepperstone MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its sub-directories.

When the installation is complete start the MT4 up and check that the EA appears in the Navigator
window (View > Navigator):

Now everything is set up for the first activation of the TradeReceiver Expert Advisor .
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2.2 TradeReceiver Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the TradeReceiver Expert Advisor  in a
few steps.

Attach the EA to a chart

1. Drag & drop the TradeReceiver Expert Advisor  from the Navigator window (View > Navigator)
to a chart window and select the Common tab:

Note:

Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are ticked.
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2. Select the Inputs tab:

This lists the parameters of the EA where the operational aspect of the TradeReceiver EA can be
set up. For more details see the TradeReceiver EA Configuration Guide – for now click on the OK
button and let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of
product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support
site. Feel free to change your Access ID at the Web Support Centre and ensure not to
share it with anyone else. Enter the Access ID and click on the Save button:

https://my.eafactory.com/expert4x/profile/
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Tip:  If you do not remember your Access ID then click on the Help! What is my Access
ID? to see it on your Web Support Centre user profile.

The TradeReceiver EA is up and running

After successful authentication the TradeReceiver EA starts up.

The TradeReceiver Expert Advisor  has been attached to the chart. The smiley face in the top-right
corner shows that the initialisation of the TradeReceiver Expert Advisor  was successful and the EA is
now looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

https://my.eafactory.com/expert4x/profile/
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Chapter

3
 System Requirements

Overview of prerequisites in order to install and get the product up and running.

3.1 Operating System Requirements
In order to operate the TradeReceiver EA a Microsoft Windows operating system is required which
supports MetaQuotes MetaTrader version 4.00 platform.

Note that the MetaQuotes MetaTrader software is also known and often referred to as MT4.

3.2 Hardware Requirements
The minimum Random Access Memory (RAM) requirement is 512MB (0.5GB), however 1024MB
(1GB) RAM is recommended to avoid extended virtual memory usage. Note that this memory
requirement is for MetaTrader application only, excluding other applications running at the same time
(e.g. MS Office). If other applications are running parallel with MetaTrader application please increase
the RAM requirement accordingly.

3.3 MetaTrader (MT4) Requirements and Settings
The EA is compatible with MetaQuotes MetaTrader platform version 4.00 build 1353 or higher. In
general this is referred to as MT4 terminal, build 1353 or newer.

3.4 Forex Broker Requirements
The TradeReceiver EA is compatible with both 4 and 5-digit data feeds based brokers. The
TradeReceiver EA automatically detects the type of the feed and adjusts the EA parameter pip values if
and when necessary.

Both fixed and variable spread broker platforms are supported.

The selected MetaTrader based broker should allow keeping open orders on the account for long
period of time, i.e. the broker should not close and re-open orders over night for swap calculation, or
should not merge open orders for any reason.

IMPORTANT: For smooth trade management the MetaTrader application and the EA should be on-
line, up and running during all market open hours (usually Sunday to Friday).

3.5 Hedging Support Requirements
The EA may open BUY as well as SELL positions at the same time on the same market. Because of
this the broker account must support the hedging of trades.

3.6 Non-FIFO Support Requirements
The TradeReceiver EA may open and close positions out of order of the first-in-first-out (FIFO)
sequence. Therefore the broker account must support the order handling in non-FIFO manner.
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3.7 Account Type and Minimum Lot Size Requirements
A so-called Micro broker account is necessary if the available funds for the EA trading is less than
approx. $1000. The micro account allows the EA to open a position with minimum lot size of 0.01. If
you plan to use a broker account with the above funding please ensure that your broker account offers
this minimum lot size.

An easy way to double check the minimum lot size available on the broker account is to attach the EA
to a chart and check the Market Info section on the chart:

The Lot line shows Min:0.01 which tells that the minimum lot size requirement is 0.01 on this broker
account.

3.8 ECN/STP Broker Accounts
Many brokers offer Electronic Communications Network (ECN) or Straight Through Processing (STP)
accounts. Common behaviour for these accounts is the variable spread and market orders where no
initial stop loss and take profit targets can be specified. In this case the market order must be submitted
with no SL and TP values, and these values are to be set in the second step using an additional order
to the opened ticket.

The TradeReceiver EA is compatible with the above ECN/STP broker accounts and needs no
additional settings to operate on them.
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Chapter

4
 TradeReceiver EA Configuration Guide

The TradeReceiver EA configuration guide.

In order to activate the TradeReceiver EA attach it to a chart window – for more details see
TradeReceiver EA First Time Activation section.

4.1 Configuration and Operation Principles
The TradeReceiver EA operational overview.

The TradeReceiver EA manages only those tickets (a.k.a positions) on the account which belong to
the TradeReceiver EA: every order submitted to the account is marked with the MagicNumber and, in
return, only those tickets on the account will be considered by the TradeReceiver EA which are marked
with this MagicNumber.

The Sender may signal trades across multiple forex pairs and timeframes at the same time. The
Receiver EA executes them according to the Receiver EA configuration. The Receiver EA may enter
positions for multiple forex pairs and keep them open for a period of time. The Receiver EA is NOT
limited to the pair of the chart it is attached to, it may open positions on other pairs as well.

In general it is recommended to run one Receiver EA on the same broker account at a time. This helps
understanding the ongoing trades and troubleshoot situation if and when needed. If multiple Receiver
EA instances are run at the same time (i.e. multiple charts hosting the TradeReceiver EA) then each
Receiver EA must have its own unique MagicNumber configured for each chart.

Using multiple 3rd party expert advisors on the same account is only viable if each and all expert
advisor can manage only their own tickets on the account by following the magic number based
separation logic.

IMPORTANT: If you plan to use multiple expert advisors (other than the TradeReceiver EA) on
the same account please ensure upfront with the expert advisor providers that their EA's are
suitable for that as per the above.

Market MagicNumber

Single chart with the EA EA default or any other

Multiple charts: EURUSD chart 1 12400

Multiple charts: EURUSD chart 2 12401

Multiple charts: EURUSD chart 3 12402

Multiple charts: GBPUSD chart 1 12403

Multiple charts: GBPUSD chart 2 12404

Multiple charts: GBPUSD chart 3 12405

4.2 TradeReceiver EA Parameter Descriptions
The TradeReceiver EA parameter descriptions.
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4.2.1 SENDER SELECTION

 Sender: Link Service Name

Sender: Link Service Name

The name of the link service as the Sender party provides it. The name is created by the Sender so ask
the Sender for the list of names which can be entered here.

The link name itself may look like Link01 or Swing_8 and it is up to the Sender to create the name.

4.2.2 RECEIVER SETTINGS

 Signal Market Symbols

Signal Market Symbols

The list of symbols in the incoming signals which are to be replaced with the broker specific symbols on
the receiver side. The new names are listed at the Broker Market Symbols input. In short, replacing a
signal's US100 symbol with the US100Index symbol when the local broker offers the US100Index feed
instead of the US100 feed.

The Signal Market Symbols and the Broker Market Symbols are working in tandem:

• The Signal Market Symbols lists the signal symbols which are to be replaced.
• The Broker Market Symbols lists the new names for those signal symbols where the new symbol

names exist on and provided by the receiver's broker.

Refer to the examples for more details.

1. Example - Trade a regular FOREX pair like EURUSD symbol with my broker
2. Example - Trade the EURUSD.r symbol with my broker (with suffix)
3. Example - Trade the XAUUSD symbol with my broker
4. Example - Trade the XAUUSD.r symbol with my broker (with suffix)
5. Example - Trade the GOLD symbol with my broker
6. Example - Trade the US100 and UK100 symbols with my broker
7. Example - Trade the US100Index and UK100Index symbols with my broker

 Broker Market Symbols
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Broker Market Symbols

The list of new symbol names specific to the receiver's broker, replacing the symbol names in the
incoming signals. The symbol names in the signals are listed at the Signal Market Symbols input. In
short, replacing the signal's US100 symbol with the US100Index symbol when the local broker offers
the US100Index feed instead of the US100 feed.

The Signal Market Symbols and the Broker Market Symbols are working in tandem:

• The Signal Market Symbols lists the signal symbols which are to be replaced.
• The Broker Market Symbols lists the new names for those signal symbols where the new symbol

names exist on and provided by the receiver's broker.

Refer to the examples for more details.

1. Example - Trade a regular FOREX pair like EURUSD symbol with my broker
2. Example - Trade the EURUSD.r symbol with my broker (with suffix)
3. Example - Trade the XAUUSD symbol with my broker
4. Example - Trade the XAUUSD.r symbol with my broker (with suffix)
5. Example - Trade the GOLD symbol with my broker
6. Example - Trade the US100 and UK100 symbols with my broker
7. Example - Trade the US100Index and UK100Index symbols with my broker

 Trade Entry Direction

Trade Entry Direction

The Sender provides the new trade entries, including their buy or sell directions. This parameter
decides to trade with that Sender's direction or trade against it.

Trade Entry Direction Description

Same as Signal Direction

The new trade is entered as follows:

• When a trade from the Sender is a BUY then the EA
enters a BUY position.

• When a trade from the Sender is a SELL then the EA
enters a SELL position.

Reverse of Signal Direction

The new trade is entered as follows:

• When a trade from the Sender is a BUY then the EA
enters a SELL position.

• When a trade from the Sender is a SELL then the EA
enters a BUY position.

 Lots Factor

Lots Factor

The Sender provides the new trade entries, including their position lots sizings. This Lots Factor
parameter allows the Receiver to keep the same lots sizing or scale it up or down with this multiplier
factor.

Refer to the examples for more details.

1. Example - Trade with the same lots size
2. Example - Reduce the lots size
3. Example - Increase the lots size
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4.2.3 MISCELLANEOUS

 Market Name Prefix/Suffix Handling

Market Name Prefix/Suffix Handling

There are standard market names which are commonly used for currency pairs, like EURUSD,
GBPUSD, USDCHF, USDJPY etc. Many broker offers these standard market names on their MT4
platform, however some brokers may add some prefix or suffix to the market names resulting in broker
specific symbols like EURUSDecn, EURUSD.m or mEURUSD etc.

As a convenience, the EA makes an attempt to discover the broker specific prefix and suffix and use
those automatically. This makes the configuration of the EA portable between brokers, less cluttered
and visually clean.

When the EA is configured with markets other than FOREX pairs, or a mix of FOREX and and non-
FOREX markets with various prefix or suffix values then this feature may not work. In this case select
the Manual: User Defined Prefix & Suffix option and enter the prefix and suffix as seen in the MT4
Market Watch window into the EA parameters Manual Market Name Prefix and Manual Market Name
Suffix, respectively.

Market Name Suffix Handling Description

Automatic: Prefix & Suffix
Discovered By EA

The EA identifies the broker specific market name prefix and
suffix values. Attach the EA to a broker specific symbol name
with the suffix, like EURUSD.r and the EA will automatically
recognize the .r suffix.

Manual: User Defined Prefix
& Suffix

In case of variable prefix or suffix values are used by the broker
across the market names, or non-FOREX markets are used
for the EA, the automatic discovery may not succeed. With this
manual mode enter the prefix and the suffix as seen in the MT4
Market Watch window to the EA parameter Manual Market
Name Prefix and Manual Market Name Suffix, respectively.

 Manual Market Name Prefix

Manual Market Name Prefix

The user defined market name prefix, specific to the broker. This field is only relevant if the manual
option is selected for the Market Name Prefix/Suffix Handling.

If the broker has market name like mEURUSD then enter the character m into this field.

 Manual Market Name Suffix

Manual Market Name Suffix

The user defined market name suffix, specific to the broker. This field is only relevant if the manual
option is selected for the Market Name Prefix/Suffix Handling.

If the broker has market name like EURUSDecn then enter the characters ecn into this field.

 Magic Number Parameter
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Magic Number

The EA marks its orders with this value when submitting to the broker account, and picks up orders
which are marked with this magic number value. When you want to have multiple charts with the EA
at the same time then change this MagicNumber to a new and unique number for each chart. Also
ensure that none of other 3rd party EAs are using the same MagicNumber value. See Configuration
and Operation Principles section for more explanation.

4.3 Examples
Settings examples.

4.3.1 Example - Trade a regular FOREX pair like EURUSD symbol with my broker

Example - Trade a regular FOREX pair like EURUSD symbol with my broker

• Goal: My broker provides the EURUSD symbol for the regular FOREX pair market. I want to
trade the EURUSD symbol when a signal for the EURUSD comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Attach the EA to a FOREX pair without any suffix, e.g. EURUSD or GBPUSD
2. Leave empty the Signal Market Symbols as no symbol replacement is required.
3. Leave empty the Broker Market Symbols as no symbol replacement is required.

• Description: A signal comes in to trade the EURUSD symbol. The EA keeps the EURUSD name
and executes the trade on the EURUSD symbol with my broker.

Note:  A signal may come in for other regular FOREX pair symbols without any prefix or
suffix as well. The above same settings can be used for those as well.

Related reference
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.2 Example - Trade the EURUSD.r symbol with my broker (with suffix)

Example - Trade the EURUSD.r symbol with my broker (with suffix)

• Goal: My broker provides the EURUSD.r symbol for the EUR vs USD market as in general my
broker offers the symbols with the .r suffix for trading. I want to trade the EURUSD.r symbol when
a signal for the EURUSD comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Attach the EA to a FOREX pair with the .r suffix, e.g. EURUSD.r or GBPUSD.r
2. Leave empty the Signal Market Symbols as no symbol replacement is required.
3. Leave empty the Broker Market Symbols as no symbol replacement is required.
4. Market Name Prefix/Suffix Handling = Automatic: Prefix & Suffix Discovered By EA
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• Description: The EA picks up automatically the suffix of .r from the EURUSD.r chart name. A
signal comes in to trade the EURUSD symbol. The EA keeps the EURUSD name and appends
the .r suffix and executes the trade on the EURUSD.r symbol with my broker.

Note:  A signal may come in for other regular FOREX pair symbols as well. The above
same settings can be used to append the receiver side broker's suffix to those as well.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.3 Example - Trade the XAUUSD symbol with my broker

Example - Trade the XAUUSD symbol with my broker

• Goal: My broker provides the XAUUSD symbol for the gold market. I want to trade the XAUUSD
symbol when a signal for the XAUUSD comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Attach the EA to a FOREX pair without any suffix, e.g. EURUSD or GBPUSD
2. Leave empty the Signal Market Symbols as no symbol replacement is required.
3. Leave empty the Broker Market Symbols as no symbol replacement is required.

• Description: A signal comes in to trade the XAUUSD symbol. The EA keeps the XAUUSD name
and executes the trade on the XAUUSD symbol with my broker.

Note:  A signal may come in for other symbols as well. If you want to replace any of those
other symbols then list them at the Signal Market Symbols and Broker Market Symbols in
order to get them replaced.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.4 Example - Trade the XAUUSD.r symbol with my broker (with suffix)
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Example - Trade the XAUUSD.r symbol with my broker (with suffix)

• Goal: My broker provides the XAUUSD.r symbol for the gold market as in general my broker
offers the symbols with the .r suffix for trading. I want to trade the XAUUSD.r symbol when a
signal for the XAUUSD comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Attach the EA to a FOREX pair with the .r suffix, e.g. EURUSD.r
2. Leave empty the Signal Market Symbols as no symbol replacement is required.
3. Leave empty the Broker Market Symbols as no symbol replacement is required.
4. Market Name Prefix/Suffix Handling = Automatic: Prefix & Suffix Discovered By EA

• Description: The EA picks up automatically the suffix of .r from the EURUSD.r chart name. A
signal comes in to trade the XAUUSD symbol. The EA keeps the XAUUSD name and appends
the .r suffix and executes the trade on the XAUUSD.r symbol with my broker.

Note:  A signal may come in for other symbols as well. If you want to replace any of those
other symbols then list them at the Signal Market Symbols and Broker Market Symbols in
order to get them replaced.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.5 Example - Trade the GOLD symbol with my broker

Example - Trade the GOLD symbol with my broker

• Goal: My broker provides the GOLD symbol, not the XAUUSD for the gold market. I want to trade
the GOLD symbol when a signal for the XAUUSD comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Signal Market Symbols = XAUUSD
2. Broker Market Symbols = GOLD
3. Market Name Prefix/Suffix Handling = Manual: User Defined Prefix & Suffix

• Description: A signal comes in to trade the XAUUSD symbol. The EA replaces the XAUUSD
with the GOLD name and executes the trade on the GOLD symbol with my broker.

Note:  A signal may come in for other symbols as well, however those other symbols are
not replaced and the EA executes them as they come in. Only the symbols listed at the
Signal Market Symbols and Broker Market Symbols are replaced.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
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Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.6 Example - Trade the US100 and UK100 symbols with my broker

Example - Trade the US100 and UK100 symbols with my broker

• Goal: My broker provides the US100 and UK100 symbols for the DOW and FTSE 100 markets,
correspondingly. I want to trade the US100 and UK100 symbols when a signal for the US100 or
UK100 comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Leave empty the Signal Market Symbols as no symbol replacement is required.
2. Leave empty the Broker Market Symbols as no symbol replacement is required.
3. Market Name Prefix/Suffix Handling = Manual: User Defined Prefix & Suffix

• Description: A signal comes in to trade the US100 symbol. The EA keeps the US100 name and
executes the trade on the US100 symbol with my broker.

A signal comes in to trade the UK100 symbol. The EA keeps the UK100 name and executes the
trade on the UK100 symbol with my broker.

Note:  A signal may come in for other symbols as well. If you want to replace any of those
other symbols then list them at the Signal Market Symbols and Broker Market Symbols in
order to get them replaced.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.7 Example - Trade the US100Index and UK100Index symbols with my broker

Example - Trade the US100Index and UK100Index symbols with my broker

• Goal: My broker provides the US100Index and UK100Index symbols not the US100 and UK100
for the DOW and the FTSE 100 markets, correspondingly. I want to trade the US100Index and
UK100Index symbols when a signal for the US100 or UK100 comes in.

• How-to: Here is an example EA configuration how to achieve the above:

1. Signal Market Symbols = US100 UK100
2. Broker Market Symbols = US100Index UK100Index
3. Market Name Prefix/Suffix Handling = Manual: User Defined Prefix & Suffix
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• Description: A signal comes in to trade the US100 symbol: The EA replaces the US100 with the
US100Index name and executes the trade on the US100Index symbol with my broker.

A signal comes in to trade the UK100 symbol: The EA replaces the UK100 with the UK100Index
name and executes the trade on the UK100Index symbol with my broker.

Note:  A signal may come in for other symbols as well, however those other symbols are
not replaced and the EA executes them as they come in. Only the symbols listed at the
Signal Market Symbols and Broker Market Symbols are replaced.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.8 Example - Trade with the same lots size

Example - Trade with the same lots size

• Goal: I want to enter my trades with the same lots size as of the Sender's signal.
• How-to: Here is an example EA configuration how to achieve the above:

1. Lots Factor = 1.0
• Description: The EA enters the new trade with the same lots size as comes in with the Sender's

signal. If the signal has say 1.00 lots then the EA enters the trade with 1.00 lots.

Warning:  The Receiver broker may have restrictions about the minimum lots size what can be used for a trade entry. Typically this minimum is 0.01 lots for standard FOREX markets, but this maybe higher due to broker choices. The EA always observes this minimum lots size requirements from the broker and ensures that the trade has at least this minimum lots size for a new entry. This may result in increased lots size for new entry if the signal has lower lots size than the broker minimum lots size.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Reduce the lots size on page 22
Example - Increase the lots size on page 23

4.3.9 Example - Reduce the lots size

Example - Reduce the lots size

• Goal: I want to enter my trades with half of the signal's lots size.
• How-to: Here is an example EA configuration how to achieve the above:

1. Lots Factor = 0.5
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• Description: The EA enters the new trade with half of the Sender's lots size. If the signal has say
1.00 lots then the EA enters the trade with 0.50 lots.

Warning:  The Receiver broker may have restrictions about the minimum lots size what can be used for a trade entry. Typically this minimum is 0.01 lots for standard FOREX markets, but this maybe higher due to broker choices. The EA always observes this minimum lots size requirements from the broker and ensures that the trade has at least this minimum lots size for a new entry after applying the Lots Factor. This may result in increased lots size for new entry if the scaled signal lots size is lower than the broker minimum lots size.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Increase the lots size on page 23

4.3.10 Example - Increase the lots size

Example - Increase the lots size

• Goal: I want to enter my trades with twice of the signal's lots size.
• How-to: Here is an example EA configuration how to achieve the above:

1. Lots Factor = 2.0
• Description: The EA enters the new trade with doubled lots compared to the Sender's lots size. If

the signal has say 1.00 lots then the EA enters the trade with 2.00 lots.

Warning:  The Receiver broker may have restrictions about the minimum lots size what can be used for a trade entry. Typically this minimum is 0.01 lots for standard FOREX markets, but this maybe higher due to broker choices. The EA always observes this minimum lots size requirements from the broker and ensures that the trade has at least this minimum lots size for a new entry after applying the Lots Factor. This may result in increased lots size for new entry if the scaled signal lots size is lower than the broker minimum lots size.

Related reference
Example - Trade a regular FOREX pair like EURUSD symbol with my broker on page 18
Example - Trade the EURUSD.r symbol with my broker (with suffix) on page 18
Example - Trade the XAUUSD symbol with my broker on page 19
Example - Trade the XAUUSD.r symbol with my broker (with suffix) on page 19
Example - Trade the GOLD symbol with my broker on page 20
Example - Trade the US100 and UK100 symbols with my broker on page 21
Example - Trade the US100Index and UK100Index symbols with my broker on page 21
Example - Trade with the same lots size on page 22
Example - Reduce the lots size on page 22
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Chapter

5
 Knowledgebase

Frequently Asked Questions and other common use cases.

5.1 How to Download MT4

Question

How can I install the MT4 platform?

I checked the MetaQuotes site and it looks like I can only download the MT5 platform.

Answer

The way to get and install MT4 is to download it directly from your broker.

Please download the MT4 setup application directly from one of your preferred brokers web site.

5.2 How to Download the Setup Application

Question

How to download the TradeReceiver EA Setup application?

1. Visit the TradeReceiver EA Web Support Centre page.

2. Read the Web Support Centre Terms and Conditions and Privacy Policy then tick the checkbox to
accept them.

https://my.eafactory.com/expert4x/products/TradeReceiver/details/#download
https://my.eafactory.com/termsandconditions.jsp
https://my.eafactory.com/privacypolicy.jsp
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3. Click on the Download EA Setup button to download the EA setup for the MT4 terminal.

5.3 How to Install the TradeReceiver EA
The TradeReceiver EA comes with a setup application to provide a wizard based installation process to
the selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have an MT4 terminal version 4.00 build 1353 or later installed.

1. Exit the MT4 if it was running.
2. Download the latest version of the TradeReceiver EA for MT4 from the Web Support Centre

page.
3. Run the downloaded setup application. Select the MT4 instance through the setup wizard pages

to where you want the EA to be installed.
4. When the setup completes start the MT4 up. The TradeReceiver EA entry should appear under

the Expert Advisors node in the Navigator window (View > Navigator)

These pictures highlight the steps how to install the EA.

https://my.eafactory.com/expert4x/products/TradeReceiver/details/#download
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The setup application lists the available MT4 instances. Select one of them for installation target and
click on the Next.

Note:

For some earlier version Windows version the list may not contain all the MT4 instances. In this
case run the setup application as administrator and use the Add target directory... button to
navigate and pick up the desired folder.
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The default MT4 installation location would follow this pattern:

C:\Program Files (x86)\BrokerSpecificName\

but you may have selected something else while performing the MetaTrader terminal
installation. As a hint, the following shows you the default path to the main MT4 directory for
some brokers:

Broker Default Path

Blueberry Markets broker
C:\Program Files (x86)\Blueberry Markets MetaTrader
4 Terminal

Dukascopy broker C:\Program Files (x86)\Dukascopy MetaTrader 4

IG broker C:\Program Files (x86)\IG MetaTrader 4 Terminal

OANDA broker C:\Program Files (x86)\OANDA - MetaTrader

Pepperstone broker C:\Program Files (x86)\Pepperstone MetaTrader 4

Always select the main MT4 folder itself for installation target, not any of its sub-directories.
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When the installation is complete start the MT4 up and check that the EA appears in the Navigator
window (View > Navigator):

Now everything is set up for the first activation of the TradeReceiver Expert Advisor .

5.4 How to Upgrade the EA

Question

How to upgrade the TradeReceiver EA?

Answer

In order to upgrade the EA please follow these steps:

1. Download the latest TradeReceiver EA from the Web Support Centre. For detailed steps refer to
the How to Download the Setup Application.

2. Exit the MT4 terminal if it was running.
3. Execute the downloaded TradeReceiver EA setup application. Follow through all of the wizard

pages to complete the EA installation.
4. Start up the MT4 terminal.

The upgraded TradeReceiver EA will pick up and carry on managing any existing trades created by the
previous EA version.

Related tasks
Step-by-step Installation of Expert4x EAs and Indicators on page 56
How to download an EA setup in VPS environment on page 61
Related information
How to Download the Setup Application on page 24

https://my.eafactory.com/expert4x/products/TradeReceiver/details/#download
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5.5 How to Attach the TradeReceiver Expert Advisor  to a Chart
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the TradeReceiver Expert Advisor  in a
few steps.

Attach the EA to a chart

1. Drag & drop the TradeReceiver Expert Advisor  from the Navigator window (View > Navigator)
to a chart window and select the Common tab:

Note:

Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are ticked.
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2. Select the Inputs tab:

This lists the parameters of the EA where the operational aspect of the TradeReceiver EA can be
set up. For more details see the TradeReceiver EA Configuration Guide – for now click on the OK
button and let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of
product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support
site. Feel free to change your Access ID at the Web Support Centre and ensure not to
share it with anyone else. Enter the Access ID and click on the Save button:

https://my.eafactory.com/expert4x/profile/
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Tip:  If you do not remember your Access ID then click on the Help! What is my Access
ID? to see it on your Web Support Centre user profile.

The TradeReceiver EA is up and running

After successful authentication the TradeReceiver EA starts up.

The TradeReceiver Expert Advisor  has been attached to the chart. The smiley face in the top-right
corner shows that the initialisation of the TradeReceiver Expert Advisor  was successful and the EA is
now looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

5.6 For Mac Users

https://my.eafactory.com/expert4x/profile/
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5.6.1 How to Download the Setup Application on Mac

Question

How to download the TradeReceiver EA Setup application on Mac?

1. Visit the TradeReceiver EA Web Support Centre page.

2. Read the Web Support Centre Terms and Conditions and Privacy Policy then tick the checkbox to
accept them.

3. Click on the Download EA Setup button to download the EA setup for the MT4 terminal.

The file is saved into your Downloads folder:

5.6.2 How to Install the TradeReceiver EA on Mac
The TradeReceiver EA comes with a setup application to provide a wizard based installation process to
the selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.

https://my.eafactory.com/expert4x/products/TradeReceiver/details/#download
https://my.eafactory.com/termsandconditions.jsp
https://my.eafactory.com/privacypolicy.jsp
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• Ensure that you have macOS 11 Big Sur or later installed.
• Ensure that you have an MT4 terminal version 4.00 build 1353 or later installed.

1. Move the download file from the Downloads folder to your desktop:

2. Start up your MT4 terminal application and select the File > Open Data Folder menu item:

3. Double-click on the My Mac Desktop in the appearing Windows File Manager window:

and double-click on the downloaded EA Setup file (Important: double-click within this Windows
File Manager window, not in the Finder)
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4. Click on the Next of the Setup wizard pages:

5. If you see the 'No valid MT4 application...' message then click on its OK button:

6. Then click on the Add target directory... button:
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7. Select the folder [/Users/your_name/]Library/Application Support/MetaTrader 4/Bottles/
metatrader4/drive_c/Program Files/MetaTrader 4

If the Library folder is not visible then follow through the How to make the Library folder visible
on Mac topic before you go further in the installation process.

Important: do not go into any subfolder of the Program Files/Metatrader 4
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8. Once clicked on the Choose button the Setup wizard page shows the selected folder:

9. Click on the Next buttons to complete all the rest of the EA Setup. Click on the Finish button:
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10. In the MT4 Navigator window right-click on the Expert Advisors node and select Refresh or
restart your MT4:

11. The EA name appears in the Navigator window:

Now attach the TradeReceiver Expert Advisor  to a chart as usual. When you attach the EA the
very first time it may ask for your Access ID.

To review your Access ID visit your Web Support Centre User Profile page (ensure you logged
in to the site).

5.6.3 How to make the Library folder visible on Mac
By default the Library folder is hidden on Mac computers. Follow the steps below to make the Library
folder visible.

1. Start the Finder app

https://my.eafactory.com/expert4x/profile/
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2. In the Finder select the Go > Home menu item:

3. Press and hold down the Control key while you click inside of the appeared window. Select the
Show View Options menu item:
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4. In the appearing window tick the Show Library Folder box. See (1) below.

The Library folder will appear in the Home folder once the Show Library Folder got ticked. See
(2) below.

5.6.4 Download & Install the TradeReceiver EA on Mac
The TradeReceiver EA comes with a setup application to provide a wizard based installation process to
the selected MT4 terminal.

Before you start...

• Ensure that you have the login credentials to the Web Support Centre.
• Ensure that you have macOS 11 Big Sur or later installed.
• Ensure that you have an MT4 terminal version 4.00 build 1353 or later installed.

1. Visit the TradeReceiver EA Web Support Centre page.

2. Read the Web Support Centre Terms and Conditions and Privacy Policy then tick the checkbox
to accept them.

https://my.eafactory.com/expert4x/products/TradeReceiver/details/#download
https://my.eafactory.com/termsandconditions.jsp
https://my.eafactory.com/privacypolicy.jsp
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3. Click on the Download EA Setup button to download the EA setup for the MT4 terminal.

The file is saved into your Downloads folder:

4. Move the download file from the Downloads folder to your desktop:
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5. Start up your MT4 terminal application and select the File > Open Data Folder menu item:

6. Double-click on the My Mac Desktop in the appearing Windows File Manager window:

and double-click on the downloaded EA Setup file (Important: double-click within this Windows
File Manager window, not in the Finder)

7. Click on the Next of the Setup wizard pages:
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8. If you see the 'No valid MT4 application...' message then click on its OK button:

9. Then click on the Add target directory... button:
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10. Select the folder [/Users/your_name/]Library/Application Support/MetaTrader 4/Bottles/
metatrader4/drive_c/Program Files/MetaTrader 4

If the Library folder is not visible then follow through the How to make the Library folder visible
on Mac topic before you go further in the installation process.

Important: do not go into any subfolder of the Program Files/Metatrader 4
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11. Once clicked on the Choose button the Setup wizard page shows the selected folder:

12. Click on the Next buttons to complete all the rest of the EA Setup. Click on the Finish button:
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13. In the MT4 Navigator window right-click on the Expert Advisors node and select Refresh or
restart your MT4:

14. The EA name appears in the Navigator window:

Now attach the TradeReceiver Expert Advisor  to a chart as usual. When you attach the EA the
very first time it may ask for your Access ID.

To review your Access ID visit your Web Support Centre User Profile page (ensure you logged
in to the site).

5.7 MetaViewer dll could not be found

Issue

After the EA setup application finished the following error message was popped up:

There was a problem starting C:\Windows\system32\MetaViewer.dll The specified module could
not be found.

There was a problem starting C:\Windows\system32\MetaViewer64.dll The specified module
could not be found.

Solution

From the EA installation perspective you can ignore this message.

The installer was at the very last step to start up the Users Manual PDF viewer. This is a request to the
Windows operating system to start the registered PDF reader application and looks like Windows could
not start up the PDF reader for some reason. This is probably a Windows or an MT4 settings problem.

https://my.eafactory.com/expert4x/profile/
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Please double check that the EA appears in the MT4 terminal Navigator window (press Ctrl+N), it
should be listed at the section Expert Advisors.

5.8 TradeReceiver Expert Advisor  First Time Activation
Step by step guide to get the EA up and running on a chart for the first time.

The following pictures demonstrate the first time activation of the TradeReceiver Expert Advisor  in a
few steps.

Attach the EA to a chart

1. Drag & drop the TradeReceiver Expert Advisor  from the Navigator window (View > Navigator)
to a chart window and select the Common tab:

Note:

Ensure that the

• Allow live trading,
• Allow DLL import and
• Allow import of external experts

are ticked.
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2. Select the Inputs tab:

This lists the parameters of the EA where the operational aspect of the TradeReceiver EA can be
set up. For more details see the TradeReceiver EA Configuration Guide – for now click on the OK
button and let the EA start up with default settings.

Note:

At the very first time the EA may prompt for the Access ID to verify that the usage of
product is licensed.

The Access ID is pre-configured and is the same as the login name to the web support
site. Feel free to change your Access ID at the Web Support Centre and ensure not to
share it with anyone else. Enter the Access ID and click on the Save button:

https://my.eafactory.com/expert4x/profile/
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Tip:  If you do not remember your Access ID then click on the Help! What is my Access
ID? to see it on your Web Support Centre user profile.

The TradeReceiver EA is up and running

After successful authentication the TradeReceiver EA starts up.

The TradeReceiver Expert Advisor  has been attached to the chart. The smiley face in the top-right
corner shows that the initialisation of the TradeReceiver Expert Advisor  was successful and the EA is
now looking for trading opportunities.

See the smiley face in the corner:

In case of a problem getting the EA up and running please refer to the Knowledgebase section.

5.9 Frown Face Instead of Smiley Face After Attach

Issue

After attaching to chart the EA is not managing trades, a frown face appears in the top right corner of
the chart.

https://my.eafactory.com/expert4x/profile/
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EA's common parameters might be not enabled

The Allow live trading, Allow DLL imports and Allow import of external experts might be not
enabled

• Press F7 key and verify that the Allow live trading, Allow DLL imports and Allow import of
external experts are checked in the EA property dialog.

Autotrading is disabled

The AutoTrading might be disabled

• Verify that the toolbar button AutoTrading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:
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5.10 What is the Leverage of My Account

Question

What is the leverage of my MT4 broker account?

I am logged in to my demo or live MT4 account and want to know the leverage available on the
account.

Answer

The TradeReceiver EA displays the MT4 account leverage on its dashboard, at the section Account
Level Info.

See the reported leverage value at the end of the first line:

In the above picture the leverage is reported as 400, which represents 400:1 account leverage.

5.11 How to Figure Out My Broker's GMT Offset?
The MT4 platform presents its chart using the time of its broker server. The various brokers configure
their server time according to their own choice, many of them are in one of the European timezone
ranging from GMT+0 to GMT+3, but some brokers opt to have their server in the US Estern timezone,
which is GMT-5. These GMT offsets may get further adjusted for the daylight savings from March till
October of every year.

The TradeReceiver EA uses the time for trading decisions therefore its time input parameters need to
be adjusted by the GMT offset of the broker's server. This article describes how to figure out the GMT
offset specific to the MT4 broker account.

1. The Market Watch window's header shows the broker's server time, press Ctrl+M in the MT4
terminal:

This time can be compared to the GMT+0 time to calculate the GMT offset of the broker, as per
the next step.

2. In a web browser search for gmt time keywords to see the current GMT time.

3. Calculate now the broker GMT offset = 'Market Wacth time' - 'GMT time'.

For an example, assuming the following:

• Market Watch time: 18:29
• GMT time as per the search result: 15:29

Then the calculated GMT offset is 18:29 - 15:29 = 3:00 hours. In practice - in the limited context of
the forex broker servers - it is sufficient to calculate the difference between the hour parts: 18 - 15 = 3
hours.
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Note:  For broker servers located in Europe the GMT offset is likely to be in the range of 0 and
3, i.e. a zero or positive number. For broker servers located in the US the GMT offset might be
in the range of -5 and -6, i.e. a negative number. Keep in mind that these figures may get further
adjusted by the daylight savings.

Based on past experience, with no guarantee that the information is correct, these are a few sample
broker GMT offsets observed as of July 2015:

MT4 Terminal Broker GMT Offset

AxiTrader AxiCorp Financial Services Pty Ltd +3

IC Markets International Capital Markets Pty Ltd +3

InstaForex InstaForex Companies Group +3

FXCM Forex Capital Markets Inc +3

ThinkForex TF Global Markets (Aust) Pty Ltd +3

RoboForex EU RoboForex (CY) Ltd +3

Tallinex Tallinex Ltd 0

Oanda OANDA Corporation -4

MB Trading FX MB Trading Futures Inc -4

5.12 EA Is Not Starting Up After Attach to Chart

Issue

The EA reports successful initialisation and advises about disabled Expert Advisors.

Autotrading is disabled

The AutoTrading might be disabled
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• Verify that the toolbar button AutoTrading is pressed.

Toolbar button when Expert Advisors disabled:

Click to enable:

5.13 No Updates to Chart

Issue

The TradeReceiver EA does not update information on the chart for several minutes.

Connection Lost

MetaTrader should be connected to the broker's server.

1. Check the bottom right corner of MetaTrader, this is when it has lost connection to the server:

2. If connection is lost then login again or restart MT to force reconnection. Try again activating the
TradeReceiver EA when connection is back.

Demo account is expired

MT4 will not be able to connect to the demo account if it's expired. In this case MT4 will keep asking for
the login details and fail all login attempt.

• When this happens open a new demo account (right click Accounts in Navigator window and
select Open an Account).
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Market is closed

New tick information and updates to chart happens when markets are open.

• Double check that markets are meant to be open currently.

Disk is full

There should be at least 50MB free disk space available on the drive MetaTrader is installed on.

• If the free disk space is low then free up space.

5.14 Prompted for Access ID at Service Access Settings

Issue

After attaching to chart the TradeReceiver EA asks for my Access ID in the Service Access Settings
window.

Type in your Access ID

The TradeReceiver EA checks that the usage of product is appropriately licensed. After product
purchase a user profile is created on our web support site and the product can be downloaded from
that web site. The support site allows to set up an Access ID which is required by the TradeReceiver
EA to validate the product licence. By default this Access ID is configured to be the same as your
selected login name to the web support site.

• When prompted, please enter your Access ID to the window and click Save:

Tip:  If you do not remember your Access ID then click on the Help! What is my Access
ID? to see it on your Web Support Centre user profile.

Please do not share out to others your Access ID. That is against the licence agreement terms
and conditions and also all 3rd party usages will count when checking the number of EA copies
being used. Sharing out your Access ID can result in licence check failure and the EA may stop
functioning.

Keep your Access ID secure, change it away from the its default value at any time on the Web
Support Centre site.

https://my.eafactory.com/expert4x/profile/
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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5.15 How to Edit the EA Input Values

Question

How can I edit or change the settings of the TradeReceiver EA once it is attached to a chart?

Answer

In order to edit the input parameters of an EA which is already attached to a chart follow these steps

1. Select the chart with the EA: click inside the chart area which hosts the TradeReceiver EA in your
MT4 application.

2. Press F7 on your keyboard, or alternatively click on the smiley (or frown) icon in the top-right
corner of the chart.

3. Edit the TradeReceiver EA input values in the appearing EA properties window: double-click on
the current value you want to change then type in the new value.

4. Click OK when editing is complete

5.16 No Trades Due to Trade Disabled

Issue

The TradeReceiver EA got attached to a chart, the EA is up and running. It keeps submitting market
orders to the broker server. However, the broker's server does not execute these market orders,
instead, the broker says the trade on this broker account is disabled:

The broker server reports the MT4 error code 133, which means that the trade is disabled on the
account. This is not an EA issue, instead, this is an issue with the broker account. For some reason the
broker account does not allow you to trade that market.

Solution

Go through the following checklist to resolve this issue:

1. Restart the MT4 terminal to see if the restart and reconnect to the broker resolves this: In the MT4
menu select File > Exit, wait 5 seconds then start the MT4 up again.

2. Identify another symbol for the same market which is enabled for trading: In the MT4 menu select
View > Symbols and search for symbol with different/extra suffix in the name, like EURUSDecn.
Add that symbol to the Market Watch window then attach the EA to this new symbol.

3. Logging into your MT4 broker account with the investor login credentials disables trading.
Ensure that you log in to your broker account with the full trader login credentials.

4. Create another demo account with the broker.
5. Contact your broker and ask their support team to enable trading on the symbol or account

a. Your broker account may have reached some trade limits (e.g. overall maximum lots).
b. Your broker may have put (temporarily) trading limitations on your account for some reason.
c. Your broker may have to enable trading by EAs.

5.17 Connection Down Message

Issue

The TradeReceiver EA got attached to a chart and the EA is up and running. The EA monitors the
connection between the MT4 terminal and the broker server. When the MT4 loses connection to the
broker server then the EA presents this Connection Down message in its dashboard - see the orange
message as an example:
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In the above screenshot the last connection issue happened at 14:19 broker server time (chart time).

This means that somewhere along the Internet connection path from your computer to the broker
server, including your home networks, the Internet and your brokers remote networks, there was some
temporary issue resulting in data transfer interruption.

During this time the TradeReceiver EA cannot receive price feed from the broker, i.e. no ticks are
coming in. This also means that, due to the lack of price feed and ticks, the EA is not activated and
cannot perform trading or managing open trades. When the MT4 re-establishes the connection to the
broker server and price feed comes in again then the EA automatically resumes its trading operations.

Solution

In order to minimize the downtime, please ensure the following:

1. Your computer is connected to your home networks over a wire, i.e. cabled to your modem or
router. Note that wireless connectivity is more prone to connection issues.

2. Use a cable based Internet service provider, if feasible. Wireless based Internet service providers,
like mobile or cellular based Internet providers could have more connectivity issues.

3. Turn off the sleep or hibernation mode on your computer. When your computer goes into sleep or
hibernation the Internet connection would be lost.

4. If in doubt, restart your home networks: shutdown your computer, turn off your modem or router,
wait 10 seconds then turn back on the modem/router then your computer.

5.18 Computer Always-on

Question

How to ensure that Windows does not go into sleep or hibernation mode?

How to Turn off Sleep & Hibernation

Ensure that your computer is turned on throughout the FOREX market hours from Monday to Friday,
and your computer is running the MT4 application and the EA is attached to a chart. Simply leave your
computer and the MT4 up and running at all times. Please ensure that your Windows does not go into
sleep or hibernation mode:

1. Go to Start > Windows Settings > Power & Sleep
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2. Select Never in the dropdown:

5.19 Step-by-step Installation of Expert4x EAs and Indicators
In this tutorial the name of MetaTrader is used as an example. Replace the MetaTrader with your
broker specific MetaTrader name.

1. Start your MT4 terminal and select the File > Open Data Folder menu

The menu opens a File Explorer.
2. Close your MT4
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3. Check the File Explorer

• If the File Explorer shows a folder like this one below

and you see the origin.txt or the origin file go to the standard installation page.
• If the File Explorer shows a folder like this one below

and you see the terminal.exe or terminal file go to the non-standard installation page.

5.19.1 Standard EA, Indicator installation
In the opened File Explorer the origin.txt or the origin file was found.

Please follow through the steps below to install the Expert4x EA or Indicator on your MT4
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1. Double click the origin.txt file and take a note of the MetaTrader location.

2. Start the EA or indicator setup program. Follow through the setup until you reach the Select
Target MetaTrader Directory window.

3. In this window select your targeted MetaTrader's Data Folder, as per the origin.txt noted earlier,
and click Next

4. Follow through the rest of the setup application.
5. In the end click Install
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6. Check the EA or Indicator in the MetaTrader after installation

a. Start your MetaTrader
b. In the Navigator panel open the Expert Advisors section if you installed an EA or the

Indicators section if you installed an Indicator and look for the EA or Indicator.

5.19.2 Non-standard EA, Indicator installation
In the opened File Explorer the terminal.exe or terminal file was found.

Please follow through the steps below to install the an Expert4x EA or Indicator on your MT4

1. Right click on the name of the Setup application
2. Select Run as administrator (You may get a few security warning or you may need to type in the

Windows administrator password)

3. Follow through the application until you reach the Select Target MetaTrader Directory window.
4. Click Add target directory... button
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5. Navigate to your MetaTrader folder

and click OK.
6. Scroll down to the end of the list. Select the target directory. Click Next.

7. Follow through the rest of the setup application.
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8. In the end click Install

9. Check the EA or Indicator in the MetaTrader after installation

a. Start your MetaTrader
b. In the Navigator panel open the Expert Advisors section if you installed an EA or the

Indicators section if you installed an Indicator and look for the EA or Indicator.

5.20 How to download an EA setup in VPS environment
In this topic we guide you through the EA setup application download in VPS environment.

1. Start the File Explorer: Click the File Explorer
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2. The File Explorer started.

3. Select the address bar section
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4. Type in: https://my.eafactory.com/expert4x and press Enter to start the Internet Explorer

Did you get blank screen? As you see below:

If yes, please select the address bar in the Internet Explorer and type in: https://
my.eafactory.com/UserInterface/index.zul?p=1

If you got this message below you may need to adjust temporary your Internet security settings.

5. When the Web support Site is appeared please log in

https://my.eafactory.com/expert4x
https://my.eafactory.com/UserInterface/index.zul?p=1
https://my.eafactory.com/UserInterface/index.zul?p=1
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6. Select the EA name from the Product List and click Product Download in the Release List

If you got this message below you may need to adjust temporary your Internet security settings to
enable downloads.

Warning messages related to the download

• Do you want to save TradeReceiver EA_v2.0.0_Setup.exe ...?

Click Save to resolve this warning
• If you use Internet Explorer 9.0 you may get this message:

TradeReceiver EA_v2.0.0_Setup.exe is not commonly downloaded and could harm
your computer

This message is a new features in Internet Explorer 9.0. IE 9.0 has increased user security.

"When you download a program from the Internet, SmartScreen Filter will check the
program against a list of programs that are downloaded by a significant number of other
Internet Explorer users and a list of programs that are known to be unsafe. If the program
you're downloading isn't on either list, SmartScreen Filter will display a warning that the file
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isn't "commonly downloaded." It doesn't necessarily mean the website is fraudulent or that
the program is malware, but you probably shouldn't download or install the program unless
you trust the website and the publisher."

Source: http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-
asked-questions-IE9?SignedIn=1

These are the steps if you'd like to continue installing the TradeReceiver EA EA:

a. Click the Action button in the displayed message
b. In the dialog box click the down arrow to the left of More options, and click Run

anyway
7. After the successful download the Internet Explorer may show this message

To start the installation process after the download click Run
8. Clean up after the download in the Internet Explorer

5.20.1 How to enable JavaScript in your Internet Explorer

Issue

I tried to load the Web Support Centre in the Internet Explorer But the following error message
popped up.

JavaScripts are disabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet
Explorer

1. In the Inter Explorer click Tools icon
2. Select Internet options

3. Go to the Security tab

http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-questions-IE9?SignedIn=1
http://windows.microsoft.com/en-US/windows7/SmartScreen-Filter-frequently-asked-questions-IE9?SignedIn=1
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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4. Select Custom level

5. Scroll down until you see Scripting
6. Under the Active scripting select Enable
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7. Click OK

8. Click OK

9. Refresh the https://my.eafactory.com/UserInterface/index.zul?p=1 page ang login

5.20.2 How to Enable Download in your Internet Explorer

Issue

I tried to download the EA setup application in the Internet Explorer But the following error message
popped up.

https://my.eafactory.com/UserInterface/index.zul?p=1
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File download is disabled in the Internet Explorer

To download a file you may need to enable the Download in the Internet Explorer

1. In the Inter Explorer click Tools icon
2. Select Internet options

3. Go to the Security tab
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4. Select Custom level

5. Scroll down until you see Downloads
6. Under the File download select Enable



 |  Knowledgebase | 70

7. Click OK

8. Click OK

9. click the Product Download button again

5.20.3 Clean up after the download in the Internet Explorer
In this topic we guide you through how to clean up after download in VPS environment.

1. In the Inter Explorer click Tools icon
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2. Select Internet options

3. Go to the Security tab
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4. Click the Default level
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5. Click OK

5.21 How to enable JavaScript in your Internet Explorer

Issue

I tried to load the Web Support Centre in the Internet Explorer But the following error message
popped up.

JavaScripts are disabled in the Internet Explorer

To load the Web Support Centre you may need to enable the usage of JavaScript in the Internet
Explorer

1. In the Inter Explorer click Tools icon

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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2. Select Internet options

3. Go to the Security tab
4. Select Custom level

5. Scroll down until you see Scripting
6. Under the Active scripting select Enable
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7. Click OK

8. Click OK

9. Refresh the https://my.eafactory.com/UserInterface/index.zul?p=1 page ang login

5.22 How to Enable Download in your Internet Explorer

Issue

I tried to download the EA setup application in the Internet Explorer But the following error message
popped up.

https://my.eafactory.com/UserInterface/index.zul?p=1
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File download is disabled in the Internet Explorer

To download a file you may need to enable the Download in the Internet Explorer

1. In the Inter Explorer click Tools icon
2. Select Internet options

3. Go to the Security tab
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4. Select Custom level

5. Scroll down until you see Downloads
6. Under the File download select Enable



7. Click OK

8. Click OK

9. click the Product Download button again



Chapter

6
 Operational Messages

The TradeReceiver EA operational messages and resolution guide.

Expert Advisors Operational Messages

Observe the message number displayed in red in the EA dashboard. Find that EA code in the table
below and click on that number to see the details and possible resolutions:

EA Code Severity Message Description

1001 Error

Setup problem: DLL imports not
allowed. Tick Allow DLL imports
in Common tab of the properties
window.

Configuration setting is missing to
allow the EA to use dynamicaly
loaded libraries (DLLs). Enable the
load of DLLs and restart the EA.
More...

1002 Error
Incomplete EA installation: Run
setup application for MT4 instance
"<MT4DataPath>'s Data Folder"

Product installation is not complete
or damaged. Run the setup
application for the MT4 terminal
instance as displayed. More...

1006 Error
MT4 Expert Advisors are disabled:
click AutoTrading icon on MT4
toolbar to execute the EA.

EA does not perform its operations,
not monitoring nor reacting to price
movements of the market. More...

1007 Error
Live trading is not allowed (no smiley
face): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform trading
operations, there is a frown icon
in the top right corner of the chart.
More...

1008 Error

Authentication failed or interrupted
(<Stopped>, <Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The EA is not able to authenticate
the user access to the service at its
start up time. More...

1121 Error

Order close failed at bid <Bid>
for #<TicketNo> <TicketType>
cmnt:<TicketComment>
(<AttemptNo>, <TicketCount>/
<TotalTicketCount>, <Latency>ms)

Attempt to close an open trade
returned with error. More...

1163 Warning
Connection - Down X times Last
time...

The MT4 lost connection to the
broker's server. More...

2101 Error Initialization failed Initialization failed More...
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EA Code Severity Message Description

2118 Error
Service access disabled
(<AccessID>, <ConfirmationID>) -
shutting down...

The user quits the authentication
process, or the EA is not able to
authenticate the user access to the
service. More...

9104 Error Order submit failed at bid ...
Broker server rejects orders
submitted by the EA. More...

MetaTrader Operational Messages

Observe the message number displayed in white in the EA dashboard. Find that MT4 code in the table
below and click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or
market related error. More...

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

132 Error Market is closed.
Market is closed, trading is not
available. More...

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow
for more open or pending orders on
the account. More...

6.1 Operational Messages
Expert Advisor Operational Messages.

Expert Advisors Operational Messages

Observe the message number displayed in red in the EA dashboard. Find that EA code in the table
below and click on that number to see the details and possible resolutions:
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EA Code Severity Message Description

1001 Error

Setup problem: DLL imports not
allowed. Tick Allow DLL imports
in Common tab of the properties
window.

Configuration setting is missing to
allow the EA to use dynamicaly
loaded libraries (DLLs). Enable the
load of DLLs and restart the EA.
More...

1002 Error
Incomplete EA installation: Run
setup application for MT4 instance
"<MT4DataPath>'s Data Folder"

Product installation is not complete
or damaged. Run the setup
application for the MT4 terminal
instance as displayed. More...

1006 Error
MT4 Expert Advisors are disabled:
click AutoTrading icon on MT4
toolbar to execute the EA.

EA does not perform its operations,
not monitoring nor reacting to price
movements of the market. More...

1007 Error
Live trading is not allowed (no smiley
face): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform trading
operations, there is a frown icon
in the top right corner of the chart.
More...

1008 Error

Authentication failed or interrupted
(<Stopped>, <Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The EA is not able to authenticate
the user access to the service at its
start up time. More...

1121 Error

Order close failed at bid <Bid>
for #<TicketNo> <TicketType>
cmnt:<TicketComment>
(<AttemptNo>, <TicketCount>/
<TotalTicketCount>, <Latency>ms)

Attempt to close an open trade
returned with error. More...

1163 Warning
Connection - Down X times Last
time...

The MT4 lost connection to the
broker's server. More...

2101 Error Initialization failed Initialization failed More...

2118 Error
Service access disabled
(<AccessID>, <ConfirmationID>) -
shutting down...

The user quits the authentication
process, or the EA is not able to
authenticate the user access to the
service. More...

9104 Error Order submit failed at bid ...
Broker server rejects orders
submitted by the EA. More...

6.1.1 Message 1001

Code Severity Message Description

1001 Error

Setup problem: DLL imports not
allowed. Tick Allow DLL imports
in Common tab of the properties
window.

Configuration setting is missing to
allow the EA to use dynamicaly
loaded libraries (DLLs). Enable the
load of DLLs and restart the EA.
More...

Setup problem: DLL imports not allowed

Issue

The EA is not able to start up when gets attached to a chart because some of its dependencies could
not be loaded into memory. The EA requires some dynamically loaded libraries (DLL) to be loaded
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into memory from disks. When the EA configuration settings do not allow the load of DLLs then the EA
cannot start up and reports this error message.

Possible root cause

• The EA configuration does not allow for the load of DLLs.

Resolution

Enable the load of DLLs in the EA configuration dialog.

1. Attach the EA to a chart, or if already attached then select the chart and

• In case of an EA: press F7
• In case of an indicator: press Ctrl+I and double-click the name of the indicator in the list.

2. Go to the Common tab of the Property window.
3. Tick the checkbox Allow DLL imports.
4. Click OK.

6.1.2 Message 1002

Code Severity Message Description

1002 Error
Incomplete EA installation: Run
setup application for MT4 instance
"<MT4DataPath>'s Data Folder"

Product installation is not complete
or damaged. Run the setup
application for the MT4 terminal
instance as displayed. More...

Incomplete Installation

Issue

The EA is not able to start up when gets attached to a chart because some of its dependencies could
not be found on the file system.

Possible root cause

• The EA setup application was not able to perform all its steps, not completed in full.
• The product was installed manually and some of the steps were missed.
• The MT4 instance's file system got damaged, some files got corrupted or deleted.

Resolution

Download the EA setup application and execute it to get the product installed for the MT4 instance:

1. Download the setup application from Web Support Centre.

https://my.eafactory.com/expert4x
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2. Execute the setup application to get the product installed. For installation guide refer to any of the
following:

• Getting Started with the TradeReceiver EA
• Step-by-step Installation of EAs and Indicators

6.1.3 Message 1006

Code Severity Message Description

1006 Error
MT4 Expert Advisors are disabled:
click AutoTrading icon on MT4
toolbar to execute the EA.

EA does not perform its operations,
not monitoring nor reacting to price
movements of the market. More...

EA AutoTrading Disabled

Issue

The EA is not responding to price movements, not performing its logic upon data ticks coming in from
the broker. The MT4 toolbar button AutoTrading is disabled.

Possible root cause

• The AutoTrading button on the MT4 toolbar is disabled.

Resolution

Press the AutoTrading button on the MT4 toolbar.

6.1.4 Message 1007

Code Severity Message Description

1007 Error
Live trading is not allowed (no smiley
face): press F7 and tick Allow live
trading box on Common tab.

The EA is unable to perform trading
operations, there is a frown icon
in the top right corner of the chart.
More...

Live Trading Not Allowed

Issue

The EA is unable to perform trading operations, there is a frown icon in the top right corner of the chart.
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Possible root cause

• The Allow live trading checkbox is not ticked at the EA properties window.

Resolution

Enable live trading in the EA properties window.

1. Go to the chart and press F7.
2. Go to the Common tab of the Expert properties window.
3. Tick the checkbox Allow live trading.
4. Click OK

6.1.5 Message 1008

Code Severity Message ToDo

1008 Error

Authentication failed or interrupted
(<Stopped>, <Status>, <Response>,
<Reason>, <FlipOverCount>,
<Latency>)

The EA is not able to authenticate
the user access to the service at its
start up time. More...

Failed Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time and does not
start up.

Possible root cause

• The EA could not connect to the authentication server.
• The user quit the authentication process.
• There is a typo in the Access ID entered by the user.
• The TradeReceiver EA is not yet purchased by the user.
• The TradeReceiver EA was purchased, but not yet activated by the user.
• The TradeReceiver EA was purchased or a trial started, but the licensed period (e.g. calendar

days) has lapsed.
• The TradeReceiver EA was purchased, but the licensed usage limit (e.g. number of parallel

accesses) is breached by the user.

Resolution

Double check the following items to find resolution to the issue.
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1. Ensure that the computer has working Internet connection. For example, go to the Web Support
Centre and see if the page loads with no issues. When the Internet connection is working, restart
the EA by pressing F7 and clicking the OK button of the Expert property window.

2. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save
button of the Service Access Settings authentication window.

3. Ensure you have purchased the product. Log in to the Web Support Centre and select the
TradeReceiver EA from the product list. If the product is not available for download then it is yet
to be purchased at the Web Support Centre.

4. Count the number of computers you are running the TradeReceiver EA on. If it is more than
what the purchased EA licence copies allow then either shut down on the excess number of the
computers all the running TradeReceiver instances, or purchase more licence at the Web Support
Centre.

6.1.6 Message 1018

Code Severity Message Description

1018 Error
Initial SL <InitialStopLoss> is too
low. Set EA parameter 'Initial SL for
New Position' to higher than zero.

Position sizing feature is enabled but
no Initial Risk Percent or Initial SL is
configured. More...

Missing Initial SL for Position Sizing Feature

Issue

The position sizing feature is enabled and it requires both the Initial Risk Percent as well as the Initial
SL to be set higher than zero.

Possible root cause

• The Initial SL is turned off, set to value zero.

Resolution

Set the Initial SL to higher than zero value.

6.1.7 Message 1121

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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Code Severity Message Description

1121 Error

Order close failed at bid <Bid>
for #<TicketNo> <TicketType>
cmnt:<TicketComment>
(<AttemptNo>, <TicketCount>/
<TotalTicketCount>, <Latency>ms)

Attempt to close an open trade
returned with error. More...

Attempt to Close an Open Trade Failed

Issue

The EA requested to close an open trade but it returned back with error. The operation may or may not
have closed out the open trade.

Possible root cause

• The trade got closed off in the meantime by the broker server due to reaching its take profit or
stop loss limits.

• The trade got closed off by another EA.
• The trade got closed off manually.
• The price quote changed slipping the close order outside of allowed range.
• The MT4 terminal lost its connection to the broker server.

Resolution

Typically this issue is temporary and the EA recovers from this issue automatically over the subsequent
incoming data feed ticks. When this issue is reported only a few times there is no need for further
attention. In order to double check that the trade got eventually closed off follow these steps:

1. Take a note of the ticket number reported by the message something like as #12345678.
2. Go to the Account History tab of the Terminal window (press Ctrl+T).
3. Search for the ticket number noted above, in the column Order.

If the ticket is found in the Account History tab then it got closed off subsequently with success, and
no further action is needed.

In the case of connection problems, refer to the Knowledgebase topic No Updates to Chart for
resolution.

Related information
No Updates to Chart on page 52

6.1.8 Message 1163

Code Severity Message Description

1163 Warning
Connection - Down X times Last
time...

The MT4 lost connection to the
broker's server. More...

Issue

The TradeReceiver EA got attached to a chart and the EA is up and running. The EA monitors the
connection between the MT4 terminal and the broker server. When the MT4 loses connection to the
broker server then the EA presents this Connection Down message in its dashboard - see the orange
message as an example:

In the above screenshot the last connection issue happened at 14:19 broker server time (chart time).
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This means that somewhere along the Internet connection path from your computer to the broker
server, including your home networks, the Internet and your brokers remote networks, there was some
temporary issue resulting in data transfer interruption.

During this time the TradeReceiver EA cannot receive price feed from the broker, i.e. no ticks are
coming in. This also means that, due to the lack of price feed and ticks, the EA is not activated and
cannot perform trading or managing open trades. When the MT4 re-establishes the connection to the
broker server and price feed comes in again then the EA automatically resumes its trading operations.

Resolution

In order to minimize the downtime, please ensure the following:

1. Your computer is connected to your home networks over a wire, i.e. cabled to your modem or
router. Note that wireless connectivity is more prone to connection issues.

2. Use a cable based Internet service provider, if feasible. Wireless based Internet service providers,
like mobile or cellular based Internet providers could have more connectivity issues.

3. Turn off the sleep or hibernation mode on your computer. When your computer goes into sleep or
hibernation the Internet connection would be lost.

4. If in doubt, restart your home networks: shutdown your computer, turn off your modem or router,
wait 10 seconds then turn back on the modem/router then your computer.

Note:  Even the best Internet connection could see a handful of connection issues on a daily
basis. When you see more than a handful, like into 100 or more a day then your attention is
needed.

Related information
No Updates to Chart on page 52

6.1.9 Message 2101

Code Severity Message Description

2101 Error Initialization failed Initialization failed More...

Initialization failed

Issue

The EA dashboard shows that Initialization failed.

Possible root cause

• Your computer slowed down for some reason, and the EA could not start up in a timely manner.
• The EA shut down itself in order to reduce the load on your computer, and allow you to gain back

responsiveness of the computer, so you can free up some resources.
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Resolution

Sometimes this can be associated with heavy swap usage by the operating system, which could be
caused by RAM shortage, or cycles of hibernation (close the lid of the laptop). The best way to clean
this up is to simply to reboot your computer: exit the MT4, shut your computer down and boot it up
again. Do not start up any other application just the MT4 and see if the EA can start up now, after the
reboot.

6.1.10 Message 2118

Code Severity Message ToDo

2118 Error
Service access disabled
(<AccessID>, <ConfirmationID>) -
shutting down...

The user quits the authentication
process, or the EA is not able to
authenticate the user access to the
service. More...

Aborted Authentication

Issue

The EA is not able to authenticate the user access to the service at attach or restart time and does not
start up.

Possible root cause

• The user quit the authentication process.
• The EA could not connect to the authentication server.
• There is a typo in the Access ID entered by the user.
• The TradeReceiver EA is not yet purchased by the user.
• The TradeReceiver EA was purchased, but not yet activated by the user.
• The TradeReceiver EA was purchased or a trial started, but the licensed period (e.g. calendar

days) has ellapsed.
• The TradeReceiver EA was purchased, but the licensed usage limit (e.g. number of parallel

accesses) is breached by the user.

Resolution

Double check the following items to find resolution to the issue.

1. Ensure that the computer has working Internet connection. For example, go to the Web Support
Centre and see if the page loads with no issues. When the Internet connection is working, restart
the EA by pressing F7 and clicking the OK button of the Expert property window.

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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2. Ensure you enter the correct Access ID, case sensitive, without any typo, and click the Save
button of the Service Access Settings authentication window.

3. Ensure you have purchased the product. Log in to the Web Support Centre and select the
TradeReceiver EA from the product list. If the product is not available for download then it is yet
to be purchased at the Web Support Centre.

4. Count the number of computers you are running the TradeReceiver EA on. If it is more than
what the purchased EA licence copies allow then either shut down on the excess number of the
computers all the running TradeReceiver instances, or purchase more licence at the Web Support
Centre.

6.1.11 Message 9104

EA Code Severity Message Description

9104 Error Order submit failed at bid ...
Broker server rejects orders
submitted by the EA. More...

Order submit failed at bid

Issue

The TradeReceiver EA sends a trading request to the broker server which rejects the request due to
an issue on the broker side. The details of the broker side issue is described by the MT4 error code
presented in the EA dashboard right below the red error message - here is an example:

Possible root cause

In your MT4 chart, observe the MT4 error code displayed in the EA dashboard. Find that MT4 code in
the below table and click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or
market related error. More...

https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
https://my.eafactory.com/expert4x
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MT4 Code Severity Message Description

129 Error Invalid price.
The market price moved in the
meanwhile making the price in
the order not feasible. More...

132 Error Market is closed.
Market is closed, trading is not
available. More...

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

136 Error Off quotes.
No current prices available
or a broker configured limit
breached. More...

148 Error
Amount of open and pending
orders has reached the limit.

The broker account does not
allow for more open or pending
orders on the account. More...

6.2 MetaTrader Operational Messages
MetaTrader Operational Messages.

MetaTrader Operational Messages

Observe the message number displayed in white in the EA dashboard. Find that MT4 code in the table
below and click on that number to see the details and possible resolutions:

MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or
market related error. More...

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

132 Error Market is closed.
Market is closed, trading is not
available. More...

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow
for more open or pending orders on
the account. More...

6.2.1 MT4 Message 2
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MT4 Code Severity Message Description

2 Error Common error.
Connection, broker account or
market related error. More...

MT4 Message: Common error

Issue

The EA dashboard shows that there is a 'common error' on the MT4 level which blocks the
communication or trading with the broker server. This may occur after a lost connection over the
Internet to the broker server where the reconnection did not succeed properly, or due to some other
account or market related issue.

Resolution

Restart your MT4: In the MT4 menu select File > Exit, wait 5 seconds then start it up again. Hopefully
the EA 'code 2, common error' would get cleared and the MT4 would be able to operate fully again.

When the demo broker account expires this message may turn up. In this case create a new demo
account with the broker.

6.2.2 MT4 Message 129

MT4 Code Severity Message Description

129 Error Invalid price.
The market price moved in the
meanwhile making the price in the
order not feasible. More...

MT4 Message: Invalid price

Issue

The EA dashboard shows that the order failed because of the market price moved on by the time the
order reached the broker, which can happen in trading on a daily basis.

Resolution

In this case the EA automatically sends a new order according to the new market price and recovers
from this issue on its own.

Watch out for the 'Count:' figure at the end of the red error message. Only if the Count figure would
keep increasing every few seconds or so for longer than 5 - 10 minutes then a closer look would
be needed. That could be an indication of a permanent issue which may need investigation and
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intervention. In this case send a screenshot of the chart showing the EA dashboard including the error
message in full to support.

6.2.3 MT4 Message 132

MT4 Code Severity Message Description

132 Error Market is closed.
Market is closed, trading is not
available. More...

MT4 Message: Market is closed

Issue

The EA dashboard shows that the root cause of the issue was that the broker closed the trading of the
market at around midnight GMT broker time.

Resolution

This is probably due to the practice the broker switches liquidity providers (banks) at around midnight
GMT when the EU/US session ends and the Asian session kicks in. The switchover period could be
just a few minutes but may last up to an hour or so around midnight GMT. As the Count: figure is
increasing only over this short switchover period this is only a temporary issue.

The EA automatically recovers from this situation on its own and sends new orders to the broker when
the market becomes open for trading again.

Watch out for the 'Count:' figure at the end of the red error message. If the Count figure increases only
during the midnight GMT switchover period then no further action or intervention is needed. However,
if the Count figure would keep increasing at any time of the day (not only around midnight GMT) every
few seconds or so for longer than 5 - 10 minutes then a closer look would be needed. That could be
an indication of a permanent issue which may need investigation and intervention. In this case send a
screenshot of the chart showing the EA dashboard including the error message in full to support.

6.2.4 MT4 Message 133

MT4 Code Severity Message Description

133 Error Trade is disabled.
Broker disabled trading on this
account. More...

MetaTrader Message: Trade is disabled

Issue

The TradeReceiver EA got attached to a chart, the EA is up and running. It keeps submitting market
orders to the broker server. However, the broker's server does not execute these market orders,
instead, the broker says the trade on this broker account is disabled:

The broker server reports the MT4 error code 133, which means that the trade is disabled on the
account. This is not an EA issue, instead, this is an issue with the broker account. For some reason the
broker account does not allow you to trade that market.
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Resolution

Go through the following checklist to resolve this issue:

1. Restart the MT4 terminal to see if the restart and reconnect to the broker resolves this: In the MT4
menu select File > Exit, wait 5 seconds then start the MT4 up again.

2. Identify another symbol for the same market which is enabled for trading: In the MT4 menu select
View > Symbols and search for symbol with different/extra suffix in the name, like EURUSDecn.
Add that symbol to the Market Watch window then attach the EA to this new symbol.

3. Logging into your MT4 broker account with the investor login credentials disables trading.
Ensure that you log in to your broker account with the full trader login credentials.

4. Create another demo account with the broker.
5. Contact your broker and ask their support team to enable trading on the symbol or account

a. Your broker account may have reached some trade limits (e.g. overall maximum lots).
b. Your broker may have put (temporarily) trading limitations on your account for some reason.
c. Your broker may have to enable trading by EAs.

6.2.5 MT4 Message 136

MT4 Code Severity Message Description

136 Error Off quotes.
No current prices available or a
broker configured limit breached.
More...

MT4 Message: Off quotes

Issue

The EA dashboard shows that the order failed because of the current market prices are not available
due to connectivity issues, or because some of the broker constraints got breached by the order, like
quotes got outdated or moved too far away.

Resolution

The EA automatically sends a new order according to the new market conditions and recovers from
this issue on its own. There is no need for any intervention.

6.2.6 MT4 Message 148

MT4 Code Severity Message Description

148 Error
Amount of open and pending orders
has reached the limit.

The broker account does not allow
for more open or pending orders on
the account. More...

MT4 Message: Amount of open and pending orders has reached the limit

Issue



Based on the MT4 error code 148 the number of open trades reached the limit of the broker account,
i.e. there are too many open trades on the account and no more trade can be entered. This is a broker
account limitation, not an EA limitation.

Resolution

The number of open trades needs to be reduced on the broker account. If you run multiple EAs on the
account then close some of those charts with the EAs and close the corresponding trades off. You may
consider to open another broker account and start those EAs up on that new broker account.

You could also limit the number of trades this EA can open on the account - see the

6.2.7 MT4 Message 4024

MT4 Code Severity Message Description

4024 Error Internal error. MT4 terminal internal issue. More...

MT4 Message: Internal error

Issue

The MT4 Expert tab shows that there is a 'internal error' in the MT4.

The 4024 comes up when the MT4 is busy, and some request from the EA, like to refresh the chart
area, cannot be processed without delay. This is an internal issue to the MT4 due to a busy or
overloaded environment. The impact of this issue is that the chart area may get refreshed with some
delay. However, in extreme cases this may become an issue impacting the trading as well.

Resolution

If you get this 4024 only occasionally, a couple of times a day then you may ignore this message.
However, if you get this message very regularly, then your MT4 or computer could be overloaded or
its performance degraded. In this case exit your MT4, reboot your computer, and only start the MT4
up and no other applications which you do not use. If you still get 4024 messages then close some of
the charts, detach some of the EAs in your MT4. This is to reduce the load on your computer and to
eliminate this message.



Chapter

7
 Support

Please contact support@eafactory.com if you require any further assistance. Please copy
info@expert4x.com on your email.

mailto:support@eafactory.com?cc=info@expert4x.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
mailto:info@expert4x.com?cc=support@eafactory.com&subject=Support%20Request&body=EA%20name:%20%0D%0A%0D%0APlease%20describe%20here%20your%20request
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